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Introduction
StudioRack is a plugin chainer that helps you to create and mix sounds more efficiently. It lets you do complex
things in a simple way. StudioRack flexibly chains up to eight plugins per DAW instance, and it provides far more
than simple plugin chaining.
•

Using Parallel Split, you can split a rack at any point in the signal flow and send the signal to up to eight
supplemental racks for parallel processing. This lets you quickly create processing chains that are
independent of each other and of the rest of the main chainer. Very specific effects can be created and then
inserted back into the signal flow at the same insert point. And since everything can be controlled by Macros,
you can use different parallel racks for different sections of a song or scene.

•

In the Multiband Split mode, you can split the signal from the main rack and isolate the processing based on
frequency. Up to five frequency bands can be processed with different racks of plugins, so you can treat the
highs, lows, and midrange of an instrument in entirely different ways.

•

Stereo Parallel Split input can be set to L/R stereo, M/S, M, or S. This allows for targeted processing of
specific parts of the stereo image. This, combined with Multiband Split processing, provides detailed control of
what you are processing.

•

Parallel Split rack and Multiband Split rack processing do not tie up extra DAW channels or plugin instances.

•

A Macros section lets you group the controls of any of the plugins in the racks of the StudioRack instance.
You can adjust complex groupings of controls—all from one Macro. Since Macros can span several plugins,
you can create personal Macros for things you might call “shine,” or “bottom,” or whatever else. Turn one
control and you’ll adjust all the settings together. This leaves you free to create, rather than bother with
controls while you mix.

All of these features are available in both Native CPU processing and SoundGrid processing modes.
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SOUNDGRID PROCESSING
StudioRack can also operate within a SoundGrid network. This opens up two more important functions:
•

Plugin processing is offloaded from the host processor (your local DSP) to a high-speed SoundGrid server.
This provides much more CPU power than the local host can, which enables a significantly higher plugin
count.

•

When part of a SoundGrid network, StudioRack is integrated with SoundGrid Studio. This enables low-latency
monitoring and recording. This means that when the DAW is in record, monitoring switches from the DAW to
the server, which makes possible very low-latency record monitoring—an option that is not possible within the
host. Switching between DAW to server and back to DAW follows the host’s commands, in most popular
DAWs.

PORTABILITY
Move a StudioRack from one track to another or from one DAW session to another, and rack organization, plugins
and all presets will follow. Move a session from one studio to another, and the StudioRack—with all its properties—
will follow. You will, of course, need the same plugins and licenses installed and activated in both systems, but you
don’t need the same hardware. The same StudioRacks will work when using your local CPU or a SoundGrid server.
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Quick Start
FOLLOW THESE STEPS TO SET UP AND USE STUDIORACK:
1. Instantiate StudioRack on a DAW track. The plugin will open with the main chainer rack.
2. To insert a plugin into a rack slot, click on the slot’s plus sign (+). This opens the Plugins menu. Search for a
plugin by name or navigate to it by category. The plugin will open in a floating window.
3. Once plugins are set up, adjust the rack input and output levels.
4. Rack signal flow is from top to bottom. Drag a plugin up or down the rack to change its position in the signal
flow.
Use the buttons on the left side to select a view: Rack, Macro, or All.

FOR PARALLEL PROCESSING:
1. Select “Rack” or “All” view.
2. Open the Plugins menu and select “Parallel Split.” Since the position of the Parallel Split insert determines its
place in the signal flow, move the Parallel Split insert point to where you want it in the signal.
3. Use the plus sign (+) to add up to eight parallel processing racks.
4. Add plugins to the processing racks, just as you did in the main chainer rack. We suggest that you organize
the plugins so that each rack represents a single type of process. You might, for example, want to design a
set of parallel processing racks to process a drum track. On the first rack, add a bit of distortion and power to
a drum track. Start, for example with distortion. Try Abbey Road Saturator and Schepps Omni Channel, then
add PSR SuperModels for amp trash. On another parallel rack, take care of dynamics. And on yet a third rack,
create your space. All of these parallel racks take the same input signal that their signals all return to the
Parallel Split insert slot. Adjust the input and output levels and panning of the rack as needed.

FOR MULTIBAND SPLIT PROCESSING:
1. Open the Plugins menu and select “Multiband Split.” Place the insert where you want the rack to fall in the
signal flow. Use the plus sign (+) to open up to five crossover processing bands.
2. Control the crossover frequency between two bands by sliding up and down on the crossover value box. This
defines what frequencies will be processed by each band.

5

StudioRack / User Guide

TO LINK CONTROLS
There are three ways to assign plugin controls to a Macro, but (for now) we will describe only one method. Macro
assignment is discussed in detail later in this user guide.
1. Select “Macro” or “All” view.
2. Open the plugins whose controls you want to assign to Macros.
3. One at a time, right-click on a plugin control. On the Add Macro sub menu, select the Macro you want to
assign the control to. Once the control has been assigned, it will have a red trim on the plugin interface.
Assign as many controls as you like to a Macro.
4. To edit the offset, direction, or limit of a control, select “Edit Macro” from the drop-down menu. This opens
the Macros Edit Window, where you can set the range, direction, and offset of any control that’s assigned
to a Macro.
Other ways to assign and edit Macros are described later in this user guide.

USING STUDIORACK WITH SOUNDGRID
StudioRack can be used in conjunction with the SoundGrid Studio application to enhance performance. Using a
basic SoundGrid Studio configuration and a server, plugin processing can be offloaded to the DSP server to greatly
increase plugin processing. Adding an I/O and a server can enable low-latency monitoring while recording. This is
carried out with the eMotion ST mixer, which is a key element of SoundGrid Studio. There are several SoundGrid
Studio configurations—larger configurations offer more mixer channels, auxes, and groups, but all configurations
allow DSP offloading.
SoundGrid Studio must be installed and configured for StudioRack to work in the SoundGrid processing mode.
Using StudioRack with SoundGrid Studio is described later in this user guide.
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Getting Around StudioRack
Selecting a View
StudioRack has four basic sections: Racks, Macros controls, Macros editing, and floating Plugin windows. Use the
buttons on the left side to select a view.

RACKS
There is one main plugin chainer rack that accepts up to eight plugins. From here you
can also insert Parallel Split racks and Multiband Split racks.

MACROS
Macros let you link controls of one or more plugins.
Right-click on any control to open the Macro
assignment drop-down menu and assign the
control to one of eight Macros.

MACROS EDITOR
The Macros Edit Window is where the range, start and stop
points, and direction are set for Macro-assigned controls.
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Floating Plugin Panels
Click on a plugin name in a rack slot to open the plugin in a floating window.
Floating windows can be positioned anywhere
and will remain visible until closed. If a plugin
interface is hidden by another object, it remains
open and can be brought to the front by clicking
on its rack icon. Pin a window and it will remain
in front in any view or application.

Floating plugin panels are controlled
in the area above the WaveSystem
Toolbar.
Plugin channel and plugin name.
In/Out button bypasses the plugin.
Pin window. When the pin is active, this window will remain in the front.
Close all plugin windows.
WaveSystem Toolbar. Used by all Waves plugins for presets management, undo/redo, and other functions.
Appearance and tools vary slightly by plugin. To learn more, read the WaveSystem Toolbar user guide.
Hide this floating plugin window.
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StudioRack Windows

Main Insert View
The main page has eight plugin slots and input and output sections. From any slot, you can insert additional
processing racks for parallel processing and Multiband Split racks to process by frequency band.
WaveSystem Toolbar
SoundGrid Studio
Control Bar

Input Phase Reverse
Input Gain

Input Section

Main Rack On/Off
Plugin Bypass
Output Fader
Full-scale Meter

Processing View
Selector

Output
Section

Fader Position
Left and Right Peak Values
Total Gain Reduction of Main
Chainer

Main Plugins Rack

DAW Track Name
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Parallel Split View
A Parallel Split is an insert on the plugin rack that splits the signal and sends it to up to eight more racks for
additional processing. This is similar to copying the DAW source track several times, sending each copy to an aux
track for processing, and returning each signal to the DAW; except that in StudioRack all of this happens on one
track. This way, the different processes are parallel to each other, not in a series (like a chainer rack). One parallel
rack is not influenced by the others.
Each processing rack has gain and phase reverse controls, and stereo racks can be panned and rotated individually.

Racks Engaged

Input Section

Rack Bypassed

Parallel Split
Insert Point

Main Plugins Rack
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Macros View
There are eight Macro Controllers, to each of which you can assign plugin controls or other StudioRack controls.
This lets you group controls and adjust them together. Macro assignments can span several plugins, and once you
create a group, you can name the Macro.

Macro Controls

Open Macro Editor
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Multiband Split View
A Multiband Split Rack, like a Parallel Split, is an insert in the plugin rack from which you can send and return a
signal for processing. In the Multiband Split mode, there is an adjustable crossover between the processing racks,
so each rack can process different parts of the frequency spectrum. There can be up to five processing racks per
Multiband Split Rack insert.

Crossover Frequencies

Multiband Split
Insert Point

Main Plugins Rack
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Using StudioRack
Adding Plugins
•

To add plugins to a rack slot, click anywhere in a slot and choose from the list of plugins.
This is the Plugins menu.

•

You can search for the plugin’s name or browse by category.

•

The new plugin will open as a floating widow that you can position anywhere on your
displays. Click on a plugin name to close or reopen its floating window. Close a floating
window with the OS close window.

•

You can show/hide a plugin by clicking on its rack slot.

Components and Racks
Mono

Instantiated on a mono DAW track. Only mono plugins can be inserted in a StudioRack.

Stereo

Instantiated on a stereo DAW track. Only stereo plugins can be inserted in a StudioRack.

Mono-to-Stereo

When mono components are inserted, the rack is mono. If you insert a mono-to-stereo plugin,
that plugin will be stereo, as will all rack slots later in the signal flow (lower in the rack). Plugins
earlier in the signal flow (above) will remain mono.
This enables you to apply mono processing to a signal (e.g., EQ, Dynamics) in order to keep
the image tight, and then add stereo delay and reverb to create a stereo image.
A mono StudioRack can be converted to a stereo StudioRack by changing the component in
the host DAW. All plugin settings will be preserved. This is useful if you build a complex mono
processing chain, and then decide to add a stereo reverb, for example, at the end of the chain.
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Managing, Moving, and Copying Plugins
Tools for managing a plugin are at the top of the Plugin Menu.
Remove Plugin deletes the plugin from the rack slot. All parameter settings and control
assignments are lost.
Bypass bypasses the plugin while keeping it in the processing chain. It does not reduce latency
or CPU. Click on the small blue light next to the plugin name to bypass/un-bypass the plugin.
You can also bypass/un-bypass the plugin with the power button at the top of the frame.
Disable Plugin removes the plugin from the processing chain without deleting it from the rack. Disabling a plugin
removes its latency from the rack. It also frees up processing power. You can re-enable a disabled plugin without
losing its settings, controls, or automation assignments.
Copy copies the plugin and its parameters. Please refer to the next page.
Latency indicates the delay introduced by the plugin.
Rack Latency shows the total latency of all plugins in the StudioRack, including Parallel
Splits and Multiband Split racks. If no latency is declared by any of the plugins in the rack,
both latency sections will be grayed out.

MOVING PLUGINS
You can change the order of the plugins in the rack simply by dragging them up
and down. This changes the plugin’s place in the signal flow, which affects the
plugins lower in the rack. Changing a plugin’s position in the rack may alter the
gain structure of the rack, so you may need to rebalance some plugin levels.
You may choose to keep the first slot in a Parallel Split rack or a Multiband Split
rack empty. This enables you to later propagate a plugin at the top of each
rack’s signal flow without repositioning all of the other plugins in the rack.
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COPYING PLUGINS AND PLUGIN PRESETS
Any plugin and its settings can be copied to an empty rack slot or pasted into a currently populated slot.
Copy Plugin

To copy a plugin and its preset (settings), select the plugin and choose “Copy” from
the Plugins menu. In this example, Renaissance 6 EQ (REQ6) and its current preset
are copied to the clipboard

The copied plugin and its preset can be pasted into an empty slot or a slot that already has a plugin. If the slot is
populated, then Paste [plugin name] will replace the existing plugin. The preset for the replaced plugin is lost unless
it has been saved with the WaveSystem Toolbar.

You can also paste only a plugin’s preset. Select Paste [plugin name] Preset. This requires that
the copied plugin is of the same plugin family as the target. You can, for example, paste a preset
from a REQ6 to a REQ4. You cannot, however, paste a preset from a REQ6 to a Q6.
When you cannot paste presets only, then your only option is Paste [plugin
name], which replaces the plugin and its preset.
Plugins and plugin presets can be copied to and from the Main chainer rack,
Parallel Splits, and Multiband Split Rack. In the Parallel Split or Multiband
Split Rack views you can move plugins between racks. To copy a plugin to
another rack, Opt/Alt + drag the plugin.
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Using VST3 Plugins in StudioRack
StudioRack is compatible not only with Waves plugins, but with VST3 plugins from other manufacturers as well. You
can build StudioRack chains with plugins by diverse brands, including chains where Waves plugins and non-Waves
plugins are mixed.

VST3 plugins can be inserted on any StudioRack:
Main, Parallel, or Multiband. They can be inserted,
moved, and duplicated just like Waves plugins, and
they can be inserted on any slot of a plugin rack.
Third-party
VST3 Plugins

Waves Plugins

Note

StudioRack supports most VST3 plugins, but it does
not support VST plugins.

SCANNING VST3 PLUGINS
The first time you open StudioRack, you will be presented a prompt that instructs you to scan for VST3 plugins. Click
“OK” to scan the host drive and link the VST3 plugins and add them for the Plugins menu. You need to scan only
once—all future StudioRack instances will include the scanned VST3 plugins. You will need to re-scan only when
you update to a new version or StudioRack or if you add or change VST plugins.
If you prefer not to scan immediately, cancel out of the prompt. You can initiate a scan manually, as described on the next
page.
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VST3 plugins appear at the bottom of the plugins menu. If there is not a
menu item for VST3 plugins, either you have not scanned for VST3 plugins,
or none are present on the host computer.

To manage VST3 plugins, click the Toolbar Menu button (left, circled red). Go to the VST3
submenu and choose from the options.

Scan Plugins scans the host computer for all VST3 plugins. Once this scan is complete, there is
no need to rescan later, even in new sessions or on another DAW. Use this, too, to update your
list of VST3 plugins. Only the added plugins will be scanned, so this procedure is quick.
Scan Single Plugin lets you browse to a specific VST3
plugin and add it you your plugins list. Use this when you
have installed plugins in a non-standard file location, or when
you want to scan only a few of your VST3 plugins.
Clear Caches and Rescan rescans your entire library of
VST3 plugins. This also clears the list of plugins that you
have removed from the plugins folder.
Set VST3 Plugins Folder sets the folder where your VST3 plugins are stored: either in the default folder or in a user-defined
location.
Sort by… View VST3 presets list by vendor or by category.
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Parallel Split Insert
A plugin chainer is, by its nature, serial. The output of a plugin becomes the input of the next one, so each plugin’s
processing is influenced by its predecessor. Normally, this is what you want to do in a DAW insert. There are,
however, times when you want to process one signal in several different ways with several racks working in parallel.
All the racks have the same input and are not influenced serially by each other’s processing.
To process several racks in parallel, choose a plugin slot and select “Parallel Split” from
the top of the plugin menu. A Parallel Split’s position in the rack determines the place of all
of its hosted racks in the signal flow.
Each Parallel Split can host up to eight parallel processing racks.
Add and mange plugins in the same manner as in the Main Chainer. The processed signals from each parallel rack
are delay compensated and returned to the same Parallel Split slot in the Main Chainer.
To add or remove processing racks, click on the plus (+) or
minus (-) symbols at the top of the racks. When a rack is
removed, all of its contents and presets are lost. You will be
prompted to confirm this choice.

Parallel Rack input and output controls are described later in this user guide.
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Parallel Split Signal Flow

Plugin Input

Signal from Parallel Split insert in Main Chainer Rack

Signal flow
in racks

Processed signal returns to Parallel Split insert in Main Chainer Rack
Plugin Output
Main rack output
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Multiband Split
Multiband processing enables you to split a signal into adjustable frequency bands and process each band
separately. There can be up to five processing bands with four crossovers.

To adjust the crossover between
processing bands, drag the crossover
value up or down.
Add or remove processing bands
with the +/- symbol on the left.

The band limits are dynamic, so their ranges are limited by the crossover points of the adjacent bands. If, for
example, Band 1 crossover is set to 200 Hz and Band 3 is set is set to 1000 Hz, then the crossover of Band 2
cannot be lower than 200 Hz or higher than 1000 Hz. If only two bands are in use, the crossover can be adjusted
over the entire range of 20 Hz to 20,000.

DEFAULT CROSSOVER RANGES
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Crossover 1

92 Hz to 545 Hz

Crossover 2

545 Hz to 4000 Hz

Crossover 3

4000 Hz to 11,071 Hz

Crossover 4

11,071 Hz to 20,000 Hz
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Multiband Split Rack Signal Flow

Plugin Input

Signal from Multiband Split insert in Main Chainer Rack

Crossover frequencies
determine processing
rack Input

Signal flow
in racks

Plugin Output

Processed signal returns to Multiband Split insert in Main Chainer Rack
Plugin Output
Main rack output
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Internal Sidechain
There are four sideband sources for Parallel Split and Multiband Split racks. Click the SC button on the upper left corner
of a sidechain-enabled plugin and choose from the menu.
External

Sidechain signal is from the internal patch of the host DAW.

StudioRack Input

Sidechain is from plugin input, before input gain control, before main rack processing.

Parallel or
Multiband Split Input

The Split insert in the main rack is the sidechain source.

Rack # Output

A specified Multiband Split or Parallel Split rack is used to create the sidechain for a
plugin in a later split rack. Before rack gain control, before mute control, after panner.

USING THE MAIN RACK AS A SIDECHAIN
In this example, we want to drastically compress a
drum while adding distortion from a stomp. We don't
want the compressor to be triggered by the stomp
action, so it is placed after the stomp and is
triggered by a sidechain from the parallel insert split
in the main rack. When the split insert is the
sidechain source, any plugins above the split (in this
case, an SSL Channel) will influence the sidechain.

USING A SPLIT RACK AS A SIDECHAIN
A PuigTec EQ in Parallel Rack 1 is shaping the
sidechain used by HComp in rack 3. Note that
Parallel Rack 1 is muted—it is used only for
sidechain, so we do not want to hear it in the mix.
Sidechain signal flows from left to right. Split
rack 2, for example, can provide a sidechain
for racks 3 and higher, but not for rack 1.
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Input, Output, and Imaging Controls
Main Chainer
The main input and output sections are visible in all views.
The rack input level is adjustable from -24 dB to +24 dB. A small, full-scale meter with a clip
indicator shows post-fader input gain. Click on the meter to reset the clip light. There is also a
phase invert switch.
The main output section consists of a full-scale meter and a fader (range: -infinity to +10 dB). Fader
position is shown beneath the fader. Meter peak level (L/R) is shown beneath the meter. Click on
the peak light to reset the peak level and clip indicators.
The host DAW track name is displayed at the bottom of the output section.

Parallel and Multiband Split Racks Input
The Parallel racks and Multiband Split racks have input
controls and phase reverse buttons at the top of each rack.
Click on the rack’s number to turn the rack on or off.
Select the rack input source with the drop-down menu.

Main Rack: Stereo
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Stereo Parallel Split
Stereo Source

Stereo Parallel Split:
Mono Source

Note: A stereo StudioRack output is always two channels,
even if the input source is mono (e.g., left, right, mid, or sides).
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Panning, Rotation, and Rack Output Level
Stereo Source
Rack On

Mono Source
Rack Off

A stereo rack with a stereo source (image on the left) can be
panned and rotated. A stereo rack (right) with a mono source can
be panned but not rotated.

Pan/Balance Control Knob
A mono StudioRack has a mono input and output. A mono signal (i.e., left, right, mid, or sides) in a stereo rack can
be panned between left and right channels. Turning the knob causes a gain decrease in one channel and a
corresponding increase in the other. The sound image moves left and right, but the internal balance may be affected.
Stereo Rotator
When working with a stereo component, the S1 stereo rotator lets you move an entire stereo image, to change its
size asymmetrically and to change the width of the image. The colored area around the panner indicates the width
and orientation of the stereo image. Drag this area to rotate the image. This moves the entire stereo image, so the
internal balance is unchanged.
Stereo Width Adjust
Drag up and down on the “W” button to change the width of the stereo image. When you drag the width value to less
than zero, the sides of the stereo image will reverse. The colored ring will turn brown to indicate this condition.

A
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OTHER RACK OUTPUT CONTROLS AND DISPLAYS
Rack Output Fader
Range: -infinity to +10 dB
Rack Output Meter
Range: -infinity to 0 dB
Solo
Solos the rack with respect to the other Parallel Split or Multiband Split racks in this insert. It does not mute other
plugins in the main rack.
There is no Mute button on a Parallel Split or Multiband Split rack. Use, instead, the Rack On/Off button at the top of
the rack.

Track Name
The name of the DAW track on which this StudioRack is instantiated is displayed in the box
below the meters. If you change the track name in the DAW, this name will change
accordingly. Some DAWs do not support track naming, in which case you can fill in the Track
Name manually.
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Latency
Latency is the delay imposed on a signal as it passes through a buss. The most
common source of latency is plugin processing, but buss summing can also
increase delay. It’s likely that different racks will have different latencies, since
each has its own plugins. When these racks are summed, they must be timealigned. Otherwise, their signals may not be in sync.
StudioRack measures the total latency of all of the plugins in the main rack,
which includes the latency of any Multiband Split racks and Parallel Splits and
their plugins. Once calculated, this latency is reported to the DAW’s latency
compensation engine.
The latency of a specific plugin as well as the total latency of the StudioRack are
shown at the bottom of the plugin menu. There are two latency indicators:
Latency of the selected plugin: 117 samples
Latency for all busses and plugins in the StudioRack instance: 182
samples.

This value is reported to the Host.

In native StudioRack, buss latency and the maximum number of plugins in the DAW session is determined by the speed and
power of the host computer. The faster its CPU, the more plugins it can process simultaneously.
When a StudioRack is connected to a SoundGrid network with a SoundGrid server, all plugin processing is offloaded to the
server. This greatly increases the number of plugin instances, and can reduce system latency.
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Using Macros
One instance of StudioRack can hold many, many plugins. It’s likely that from time to time you will want to adjust
several controls on one or more of these plugins simultaneously. You may want, for example, to simultaneously
control a number of parameters to adjust a type of effect you named “Sparkle” so that you can dynamically control
whatever it takes to add or reduce the “sparkle” of that instance.
StudioRack lets you do this easily. Each instance of StudioRack has eight
Macro control knobs that let you link controls on any of its hosted plugins in
the Main chainer rack, the Multiband Split racks or the Parallel Split racks.
You can assign controls to a Macro knob, then adjust the range, scope, and
direction of each control.

ASSIGNING PARAMETER CONTROLS
There are three ways to assign parameter controls to a Macro:
1. Assign from a Macro knob.
2. Assign from a plugin control.
3. Assign with the Assign button at the bottom of the Macros panel.
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ASSIGN MACROS FROM THE MACRO KNOB
1. Right-click on an unused Macro knob. You will see a list of all the inserted plugins
in the main plugin slot, including Parallel Split and Multiband Split racks. In
Parallel Split and Multiband Split racks, the letter “S” followed by a number
identifies the rack slot number.
2. Click on a plugin name to open a drop-down menu of the controls that can be
assigned to the Macro.

3. Select a control to assign. Repeat for as many controls as needed. The plugin input gain and output gain can also be
assigned.
4. Double-click on the Macro name box to give it a descriptive name.
Assigning Macros to Parallel Split and Multiband Split Racks from the Macro Knob

Controls for all rack slots are listed sequentially by slot:
S1–S8 Rack 1; S9–S16 Rack 2; S17–S24 Rack 3, etc.
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Assign Macros from the Plugin Controls
1. Right-click on a plugin control that you want to assign to a Macro. This
opens the Macro Assignment menu.
2. Select the Macro to which you want to assign the control. Variable controls
(e.g., knobs, faders) and switches can be assigned.
3. In addition to plugin controls, Parallel Split and Multiband Split Rack chainer
controls can be assigned to a Macro.
Any number of controls can be assigned to a Macro, but a single control
can be assigned to only one Macro.

Assign Macros with the Assign Selector
1. Click the Assign button. All Macros will flash.
2. Select a Macro. It alone will continue to flash.
3. Click on the controls that you want to assign to the Macro. You can assign controls in any plugin, in any rack,
in any number, within this instance of StudioRack.
4. Click Assign to save and exit the assignment.
A plugin control that has been assigned to a Macro is outlined in
red.
To remove a control from a Macro, or to assign it to another Macro,
right-click on the control and choose from the menu.

29

StudioRack / User Guide

Editing Macros
Use the Macros Edit Window to adjust how the assigned controls behave when the Macro is moved. There are three
ways to access the window:
1. Right-click on a Macro knob. Select “Edit Macro.”
2. Right-click on any assigned control.
3. Click the “Edit” button at the bottom of the Macro panel.

MACROS EDIT WINDOW
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Macro Number

Identifies the Macro Control knob.

Plugin Name

Defines what populates this slot:
(2a) Main rack controls (not plugins) are identified with “Main Rack.”
(2b) A plugin in the Main rack is identified by its name.
(2c) Parallel Splits and Multiband Split Racks do not identify their hosted plugins here.

Control Name

Identifies a control within the Plugin (Plugin Name) that is controlled by the Macro.
Parallel Splits and Multiband Split Racks identify controls first by processing slot number (#S),
then by plugin name, and then by the name of the control.

Slot Number

Identifies the rack slot number.

Control Range

Limits how much a control can be changed by a Macro. Also sets the direction of the control (i.e.,
high-to-low or low-to-high).

Macro Scale

Sets which part of a Macro knob’s rotation will affect the control.

Control Range sets the minimum and maximum values of the plugin or rack control that is assigned to a Macro.
At its default setting, the assigned control will move through its complete range, directly
linked to the Macro knob.
When the range is reduced, the control will be limited to a narrower range, even when the
Macro knob turns entirely. In this example, the control will move only between 50% and
70% of its range. Drag up or down over a value box to change its setting.
The arrows in the middle reverse the direction of the control.
Macro Range sets the points in the movement of the Macro at which the control will begin and end its movement.
At its default setting, the assigned control will begin and end its movement with the full
range of the Macro.
Limiting the Range means that the assigned control will begin and end its movement only
when the Macro is within your defined limited range.
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Assigning a VST3 Plugin Control to a Macro
VST3 plugin controls can be controlled by a Macro in the same manner as Waves plugins. There are two ways to
assign a control in a VST3 plugin to a Macro:
1. Assign from the Macro knob.
2. Assign with the Assign button at the bottom of the Macros panel.
Unlike with Waves plugins, you cannot assign a VST3 plugin to a Macro by right-clicking on the control.

About Automation
If you are automating a very large number of plugins in the Main rack and Parallel Split and Multiband Split racks, we suggest
that rather than assigning controls with the DAW’s plugin automation panel, you assign directly from the controls themselves.
This prevents running out of automation lanes and thus not seeing the control when automating. Select a control and then
Ctrl+Opt+Cmd+Click (Mac), Ctrl+Alt+Win+Click (PC) Pro Tools only.
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Using StudioRack with SoundGrid
Using StudioRack together with SoundGrid Studio opens new processing capabilities. SoundGrid is the Waves
networking protocol that connects and controls devices on an Ethernet network, and SoundGrid Studio is the
application that controls this network.
•

When StudioRack is used as part of a Waves SoundGrid network, plugin processing is offloaded from the host
computer to a dedicated SoundGrid server. This results in a significant increase in the total number of plugins
that can be used simultaneously.

•

A StudioRack can become an integral part of SoundGrid Studio’s eMotion ST mixer. This enables low-latency
monitoring and recording, and it lets you control up to 16 StudioRacks at once.
•

When a StudioRack is in Playback mode, the signal plays through the DAW’s StudioRack plugin, with its
inserted plugins. This is normal DAW playback. But when you switch the StudioRack to Input mode, DAW
playback is bypassed from the DAW, and all processing—with the same plugins—takes place inside the
mixer. Monitoring from the Mixer eliminates system latency and lets the artist hear an
uninterrupted input signal while recording.

•

Switch back to Playback mode and you will once again hear playback from the DAW. Several grouped
StudioRacks can automatically punch in or out together, triggered by the DAW transport.

A StudioRack (in SG mode) that has been assigned to a SoundGrid Studio input channel will appear in the eMotion
ST StudioRack layer with the same functionality as other mixer channels.
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SoundGrid Essentials
This is an overview of using StudioRack with SoundGrid Studio. For information about setting up, configuring and using
SoundGrid Studio, please refer to the SoundGrid Studio user guide.

To use StudioRack in the SoundGrid mode, the host computer must be running SoundGrid Studio and the
SoundGrid network must include a server and at least one I/O device. A non-SoundGrid I/O device can be integrated
into the network using SG Connect, but offload processing will not occur in real time. To enable real time offload
processing, a SoundGrid I/O must be used (this is described later).
When you first set up SoundGrid Studio, you will be prompted about how you want to configure your I/O devices and
server, as well as your monitor I/O channel. Once SoundGrid Studio is installed and configured, SoundGrid
processing will be available to all instances of StudioRack in the DAW session.
A small SoundGrid Studio icon on the Menu Bar (Mac OS) or Task Bar (PC) shows that SoundGrid
Studio is running.
Use the drop-down menu to move directly to a window or to quit the application. SoundGrid Studio will
launch automatically the next time you start the computer or if you choose to launch it manually.

A SoundGrid network includes these components:
HOST COMPUTER: CONTROL SOUNDGRID STUDIO AND THE DAW
The host computer controls the mixer and the SoundGrid network that connects all devices and
streams audio. Applications, plugins, and preset files are located here. With Native systems,
plugins processing is carried out on the host. When a SoundGrid server is assigned to the system,
processing is done on the high-speed server.
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SOUNDGRID SERVER AND I/O
OFFLOAD PLUGIN PROCESSING AND ENABLE LOW-LATENCY MONITORING
To offload processing, add a SoundGrid server and at least one
SoundGrid I/O. The StudioRacks in the DAW session control
the connections to the mixer and the DAW. For offload
processing alone, you can use SG Connect, a feature of the
SoundGrid driver, assign an ASIO/Core Audio device driver to
SoundGrid Studio. This replaces a SoundGrid I/O for offload
processing.
Use a SoundGrid I/O and you can also use the SoundGrid
Studio eMotion ST mixer. This is a full-feature studio mixer that
enables low-latency monitoring during recording. This feature is
not possible with non-SoundGrid I/O devices.
The speed of the server has a direct impact on the number of SoundGrid channels and plugin instances. There are a
number of server configuration options. Visit www.waves.com/hardware for up-to-date specifications and
requirements about severs and other hardware components.
When there is more than one device in the network, you must use a 1 Gb Ethernet switch to connect all devices. We
advise against “daisy chaining” from one device to another.

TO SET UP SOUNDGRID STUDIO, FOLLOW THESE STEPS:
1. Install the SoundGrid Studio app from Waves Central.
2. Connect the server, I/O devices, and the host to the Ethernet switch using Cat. 5e or better Ethernet cable.
3. Launch SoundGrid Studio.
Please refer to the SoundGrid Studio user guide for setup details.
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SETUP WINDOW OVERVIEW
When you first launch
SoundGrid Studio, it will
configure itself based on your
inventory and your needs. If
StudioRack encounters
problems communicating with
SoundGrid Studio, you will be
prompted as to what action to
take. You can then set up the
link between the StudioRacks in
the DAW session and the
SoundGrid Studio eMotion ST
mixer.
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Offloading Processing from the Host Computer to the Server
Offloading requires a server and at least one I/O. You can use a SoundGrid I/O device or a third-party device with an
ASIO/Core Audio driver. Each DAW channel for which you want to offload processing must have an instance of
StudioRack.

Adding a Server
Configuring the server is just a matter of connecting it to the Ethernet switch and powering it up. SoundGrid Studio
will detect the server, ask if you want to assign it, and then add it to your inventory. If the server requires a firmware
update, the “FW” button on the server icon will be lit. Click on the button and the firmware will be brought up to date.

Assigning an I/O Device
USING A SOUNDGRID I/O DEVICE
1. Launch SoundGrid Studio. If this is the first time you have opened SoundGrid Studio, you will need to Autoconfigure.
2. Configure the DAW for Offload Processing:
a. Launch your DAW.
b. Select “Waves SoundGrid” as the playback engine.
c. Insert StudioRack on all channels that will be offloaded to the SoundGrid server for DSP processing.
d. Open each StudioRack and set the StudioRack Processing mode to “SG.”

USING A NON-SOUNDGRID I/O DEVICE
SG Connect is a feature of the SG Driver that enables an ASIO/Core Audio device to appear in the SoundGrid
Studio inventory as a SoundGrid I/O. This lets you incorporate a non-SoundGrid device in a SoundGrid network for
high-speed offload processing. When you run Auto Config and if no SoundGrid I/Os are present in the network, you
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will be asked if you want to assign the SG Connect driver. If so, it will be assigned its dedicated slot. It can be
assigned only to this slot.
An assigned ASIO/Core Audio device (e.g., RME, MOTU) appears in the Local Devices assignment submenu.
Once assigned, the device will appear in the assignment menus and the
Patch just like any other device.

CONFIGURE THE DAW FOR OFFLOAD PROCESSING
a.
b.
c.
d.

Launch your DAW.
Select your audio interface’s driver as the playback engine (“Windows built-in” must use ASIO4ALL).
Insert StudioRack on all channels that will be offloaded to the SoundGrid server for DSP processing.
Open each StudioRack and set the StudioRack Processing mode to “SG.”

There’s nothing else to set. All DAW channels with a StudioRack in the SoundGrid processing mode will offload
processing to the server.

The SoundGrid Connect feature is designed primarily for the studio, to help you offload CPU from your computer
to a SoundGrid server. It is not recommended for live sound or low-latency monitoring while recording.
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Low-Latency Monitoring During Recording
Low-latency monitoring while recording is accomplished by sending the input signal from the I/O directly to a
SoundGrid DSP server (see diagram). When StudioRack is in playback mode, the monitor signal passes though the
DAW, as is expected. When the StudioRack monitor status switches to input, the I/O input signal is split to two
paths. One path goes to the DAW and the second—for low-latency monitoring—goes directly to the inserted
StudioRack, bypassing the DAW buffering latency.
During recording, the DAW output is muted and
only the direct sound from the SoundGrid DSP
server is heard in the control room or
headphone monitor mixes. This prevents
“double monitoring,” the phase error of audible
doubling that would result from combining both
signals due to the greater latency of the DAW
output.
When recording is finished, the monitor path
switches back to the output of the DAW—with
StudioRacks in playback mode—for normal
playback. You hear the same processing
during recording and playback without having
to commit to specific mixes or processing.
Low-latency monitoring requires at least one
SoundGrid DSP server and one I/O. It requires
no special setup. StudioRack must be in
SoundGrid DSP Processing mode.
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StudioRack Monitor Setup
The SoundGrid Connection panel is used to establish a link between each StudioRack and the mixer.
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SoundGrid Status
(WSG)

Indicates SoundGrid server status. When green, the server is working properly. Red indicates an
error in the configuration. Clicking the WSG button will display the error and show the SoundGrid
Setup window so that you can address the problem. All StudioRacks will mute when the server is
missing. The shaded indicator bar and the numeric displays show average CPU of all cores. Click
on the WSG button to access the SoundGrid Studio Setup window.

DSP Percent

Shows the peak DSP load of the core with the highest CPU.

Voices

Displays the number of SoundGrid Studio channels being used between the StudioRack and the
eMotion mixer. This is independent of the voices used in the DAW. A mono StudioRack takes one
voice, a stereo StudioRack requires two, and a side chain requires one more.

SoundGrid/Native

Switches between SoundGrid and Native modes. This must be set to SG to link the StudioRack
with the mixer.

Monitor Source
Selector

Sets the I/O that will serve as input to the server when the StudioRack is in Input. The StudioRack
will not appear in the mixer if an I/O channel is not selected.

PB/Input/Auto

Controls the monitor status of the StudioRack. When set to PB, audio is played from the DAW.
When set to Input, such as during recording, the signal is “hijacked” and sent to the server for
faster processing. Auto switches between Input and Output, following commands from the DAW.

Group

Assigns several StudioRacks to a group for switching between Input, Playback, and Auto modes.
When Group is selected in a StudioRack, it is a member of the switching group. Change the mode
of any StudioRack and the others will follow.

Mixer Access

Click to open the StudioRack layer of the mixer.
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FOLLOW THESE STEPS TO CONNECT
a) Open the DAW session and set the Playback Engine to “Waves SoundGrid.”
b) Insert a StudioRack on each track where you want to perform low-latency monitoring while recording.
c) Confirm that the WSG logo is green. If it’s not green, click to access the SoundGrid Studio Setup window to
address the problem.
d) Assign the StudioRack input I/O channel used for low-latency monitoring during recording.
e) Switch monitor signal between input and play. Monitoring can also switch automatically based on the host’s
record/play status. This is explained later in this section.
f) Group together several StudioRack instances so that they change status simultaneously.

Establishing a Link Between StudioRack and eMotion ST
Each channel in the StudioRack layer of eMotion ST is one StudioRack instance in the DAW, so there must be a
way of establishing a link between the two. There are two links that must be established: one between StudioRack
and eMotion ST, another between StudioRack and the input channel of the DAW.
Set StudioRack to the SG processing mode. This moves StudioRack processing to the
SoundGrid DSP server and establishes an initial connection between the mixer and the
StudioRack. “Switch All to SG” or “Switch All to Native” simultaneously switches all
StudioRack instances in the host session to SoundGrid or Native respectively. eMotion ST
will not recognize StudioRack channels that are set to Native CPU.

VST3 SoundGrid Compatibility
VST3 Plugins are not SoundGrid compatible. When a StudioRack is in SG mode, the VST3
plugins are disabled. This does not affect the Waves plugins in the rack or change the signal
flow. The StudioRack continues to operate in SG mode. The VST3 plugins are reactivated
when the StudioRack is returned to Native mode.
Disabled VST3 Plugins
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Mixer StudioRack Layer
The StudioRack mixer layer is made up of the StudioRack instances in the Host DAW session.
Each StudioRack channel is one StudioRack instance. If there are no StudioRack instances linked
with the mixer, this layer will be blank.
The SuperRack layer includes the Input, Route, Aux, and Monitor 1–16.
When part of a SoundGrid network that includes a SoundGrid server and at least one SoundGrid
I/O, a StudioRack plugin is integrated with the eMotion ST mixer. This enables low-latency
monitoring and recording, and it lets you control up to 16 StudioRacks at once.

If the StudioRack layer button is active but some StudioRacks do not appear in the mixer, it
probably means that those StudioRacks are not assigned to I/Os.
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Linking StudioRacks to the Mixer
To populate channels in the eMotion ST StudioRack
layer, set the StudioRack input channel to match the
driver input channel in the DAW track where the
StudioRack is inserted.
This StudioRack instance will appear as a channel
strip in the StudioRack layer of the mixer. The
channel input will match the Input assignment in the
StudioRack plugin.
By setting the StudioRack input to the same source,
switching from Input to Playback will match.
Track Name: Each instance of the plugin will show
the track name it is instantiated on. Please note that
some DAWs do not support track naming. When
working with such DAWs, you can fill in the Track
Name manually.

Switch between Playback, Input or Auto in the mixer or on the StudioRack plugin. When a
StudioRack is in Playback mode, it and all members of the group are muted, since StudioRack is not
active and does not stream audio in the mixer during playback
You can assign a StudioRack to the switching group either on the StudioRack plugin instance or on
the mixer. Switch any member of the group to Playback, Input or Auto, and all other members of the
group will switch.
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A StudioRack’s placement in the mixer is directly related to the position of its device in the rack (Setup window). If,
for example, you select IOS channel 5 in StudioRack A and IOX channel 2 in StudioRack B, the placement of these
channels in the mixer will be determined by which device slot the IOS and IOX are assigned to in the Setup
inventory. Within a device, track order in the mixer is determined by input channel number, with lower channels
placed to the left of higher ones.
You can load the SoundGrid Studio session that is associated with the current
StudioRack. Go to the Load menu at the top of the plugin and select “Load SG Studio
Session.”

Automatically Linking to DAW Playback/Input and Auto Monitor Status
StudioRack can be set to follow a DAW’s input channel selection and its monitor switching. This means that, with
certain DAWs, you need to set the channel input source only once, in the DAW channel.
To enable monitor syncing with the DAW, select “Enable INP/PB Sync to DAW,” in the
SoundGrid Studio Setup window.

Once Sync to DAW is enabled, the StudioRack input channel selection
will mirror input channel selected in the DAW.
In addition, Sync to DAW enables automatic monitor switching.
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In this example, a section has been selected for a punch-in
recording in the DAW (the small bar at the top, between “2” and
“3.”) The play head is on the left, indicated by the arrow. As it
approaches the punch-in, the DAW is in playback. The
StudioRack follows this command and displays (A)PB.

When the DAW goes into record, the StudioRack switches to
input.

At the end of the punch-in, the DAW and the StudioRack return
to playback.
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Set Up a Mackie HUI in a DAW
Setting up a MIDI controller using HUI protocol varies
from one DAW manufacturer to another. It consists of
selecting a HUI protocol virtual controller and then
assigning Waves SoundGrid and StudioRack to
“Receive From” and “Send To.” SuperRack does not
need additional configuration.

Controller configuration varies by DAW manufacturer.
The following are examples of how to set up a Mackie HUI in the most popular DAWs. If you cannot find the
information you’re looking for, refer to the user manual or website for your DAW.
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Logic Pro X
1. Go to Logic Pro X menu > Control Surfaces > Set Up.

2. On the upper left side of the window, click on
“New” and choose “Install.”

3. Choose “Mackie Designs. Then select “HUI” and then click on “Scan.”

4. A pop-up window will appear. Click on “Add
Manually.”

5. In the HUI Device window, set “Output Port” and “Input Port” to
“StudioRack.”
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Pro Tools 11
1. Go to Setup.

2. Choose Peripherals.

3. Click on the MIDI Controllers tab and set one of the slots to “HUI.”

4. Set “Receive From” and “Send To” as “Waves SoundGrid
StudioRack.”
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Cubase
1. Go to Studio > Studio Setup.

2. On the top left corner of the window, click on the “+” icon
to add a device.

3. Choose “Mackie HUI.”

4. In the Mackie HUI window, assign “MIDI Input” and “MIDI
Output” to “Waves StudioRack.”
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Studio One
1. In the Studio One upper menu, go to Studio One > Preferences.
2. Click on the “External Devices” tab.
3. Click on “Add” to add a device.
4. Open the Mackie folder and Choose “HUI.”
5. Set “Send and Receive From” to “Waves SoundGrid StudioRack.”
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Digital Performer
1. In the Digital Performer top menu, go to
Setup > Control Surfaces Setup.

2. In the small window that opens, click on “+” to add a device and choose
“HUI” from the list.

3. Set “Input and Output” ports to “Waves SoundGrid StudioRack.”
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Reaper
Go to the Options menu > Preferences.

Select “Control/OSC/web”
at the bottom of the list.

Click on “Add,” then select “HUI (partial).”

In “MIDI Input” and “MIDI Output” select “Waves Audio Ltd. – Waves
SoundGrid – StudioRack.”

Click “OK.”
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